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1.

ikl

GD32 MCU#ZH£IEC60730 ClassBililEE S #f, X T R4 £411GD32 MCU, #i& 2t F &

FIH TRERAR, P AEXT ] — R A E RS (85 B 47 IEC60730 H RS A IERT, Wl @il F8 A A%

R FRIEA B Ax & R o AR 2 0% 17 4/ 44 GD32F3x0 % 41 i85 7 1£ A [A] IDE
(Keil/lAR/eclipse) T, P REEED, # P& P #EIEC60730 ClassBiliilFE.
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GigaDevice F T GD32F3x0 %%/ IEC60730 ClassB FEf%1E15r
2. IEC60730 ClassB AiEFEME
GD32 MCU#LIAR. Keil. eclipse?f 1 FIIEC60730 ClassBililF S #, =MIT KA R
AR TREMBAEAAEZE S . NN =R I RIASE I U
AN 4105 T-GD32F350RBH#E4T T A2 R Ut B .

2.1. IAR RN IEE TREBE

1. MR HdE T HME 2gd32f3x0_test.h S 4w 3 %:__IAR_SYSTEMS_ICC__ T [JRAM
B, nfR-1. #£2qd32i3x0 test.h FRAMZIE7K -

2-1. & gd32f3x0_test.h H RAM 45

F#ifdef _ IAR SYSTEMS_ICC

ICFEDIT_region ROM_start_ ;
Te

RAM start_ ;

RAM end_ :

RRAM start_ ) )
RAM end

L end )
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& 2-2. %N ClassB FE X3 IAR T8

Files e B
= @ FProject - Debug
M Application

B CMEIS

M Doc

B GD32F3x0_EvAL
B GD32F

g,

]

[r] gd32f30_test_cpu_prerun_lAR.s
[5] gd32f3x0_test_cpu_run_|AR.s
A ] gd32{3=0_test_flash.c

[5] gd32{3x0_test_fullram_run_|AF.s
A 2] gd32{3x0_test_param.c
gd32fix0_test_prern.c
go32{3x0_test_ram.c

—H [ gd32{3x0_test_run.c

— 2] readme i

B Starup

B Output

HEHEBBMEBEE

GRACHMFELMSARES, WERBES: HEA/FE, W55 ZALE 4 E Sk
GD32F3x0_Firmware_Library\CMSIS\GD\GD32F3x0\Source\ARM T, & #4557 & 24 i 45
RN sRBIAE, I AR2-3. B3 B mET BN, S R 5T AR
s

& 2-3. Bik.s B3I

MODULE “?Pcstartup
;: Forward declaration of sections.
SECTICH CSTACE:DATZ:NORCCT(Z)
SECTICN .intwvec:CODE:NCRCCT (2)
EXTERN test prerun
EXTERN _ iar_ program sStart
EXTEEN SvystemInit
PUBLIC _ vector_table
DATR
_ wector_takle
DD sfe (CSTACK) ;s top of stack
DCD ; Vector Number 1,test_prerun
DCDr NMI Handler ; Vector Number 2,HNMI Handler
DCD HardFaalt_Handler ; Vector Humber (Hard Fault Handler
DCD MemManage Handler ; Vector HNumker <,MPU Fault Handler
DD BusFault_ Handler ; Vector Number 5,Bus Fault Handler
DCD UsageFault_Handler ;s Vector Number o©,Usage Fault Handler
DCD ; Reserwved
DCD ; Reserwved
DCD ; Reserwved
DCD ; Reserwved
DD SVC_Handler ;s Vector Number »SVCall Handler
DCD DebugMon Handler ; Vector Number Debug Monitor Handler|
DCD ; Reserwved
DCD PendSV_Handler ; Vector Humber . PendSV Handler
DCDr SysTick Handler ; Vector Number SysTick Handler
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2 . B % T B p & X # ¥ C #E K il p
A: .\GD32F3x0_IEC_Test\GD32350R_EVAL_Demo_Suites\Projects\IEC_Tesn\EWARM) T~
IEC_TEST_BOOT_FLASH.icf3C 1, 1 &R2-4. 304 BmEe XA s G i, i
O BE T HE 2 Flash FIRAM) K /N IE BE 24 7T o8 A o

& 2-4. BB EUMER S

1 /*###ICF### Section handled by ICF editor, don't touch! *&¥¥jf

2 f*-Editor annctation file-%/f

5 /* IcfEditorFile="STCCLEIT DIRS\gonfighidsh\IcfEditorhcortex vl O.zml"™ */
[ *-Specials-*/

~ define symikol  ICFEDIT intvec start = 0x08000000;
& f*-Symbols-*/
7 define symbol  ICFEDIT region ROM start = 0x08000000;

8 define symbol  ICFEDIT region ROM end Ox0B01FFFF;

define symikol  ICFEDIT region RAM start 0x200000B0;

10 define symikyol  ICFEDIT region EAM end =] 0x20003FFF;
11 define symbol  ICFEDIT region IECTEST PARAM start 0Ox20000040;
12 define symbol  ICFEDIT region ITECTEST PARAM end Ox200000BO;

I
I

3. 1&i%Options for node ‘Project' H TargetfIFL & , £ U Fnd RS, Wi &2-5. Device &7
ER:

2-5. Device i &

Categony:
Static Analysis
Runtime Checking
C/C++ Compiler Library Options 2 MISRA-C:2004 MISEA-C:1908
Assembler . . . .
Target
Output Converter 9 Cutput Library Configuration Library Options 1
Custom Buid Processor variant
Build Actions
Linker D Core Cortex-M4
Debugger
Simulator
AL @® Device GO GD32F350xB T
CMSIS DAP None
GOB Server (I CMSIS-Pack
I-jet/TTAGIet
MHinkf1-Trace
I Stil;lhris Endian mode Floating point settings
Mu-Link .
PE micro Litle FPU VFPvd single precision  +
ST-LINK Big
Third-Party Driver BE3D 16
TI MSP-FET -
TIL¥D5 BEB
TrustZone
DSP Extension
Secure
Advanced SIMD (MECQN)

4. 7£Options for node ‘Project’->C/C++ Complier->Preprocessor i Il 24 i T 5% 75 Z 1 i g
B, FEBUAE LS R RN TR, W R-6. B ELT R
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GigaDevice
& 2-6. BT FE

Catsgory: Factom Settings
General Options [ ulti-file: Compilation
Static Analysis Digcard Unused Publics
Runtime Checking
MISRA-C:1998 Encodings Extra Options
Ageembler o =
Output Converter Language 1 Language 2 Code Optimizations Output
Custom Build List Preprocessar Diagnostics MISRA-C:2004
Build Actions
Linker [Jlgnore standard include directorie:
Debugger
Simulator Additional include directaries: (one per ling)
0B Server $PROJ_DIRPY NAANGD32F3x0 Firmware Libran,GD32F3x0 st

$PROJ_DIRENANAAGD32F3x0_Firmware_Librany\CMSISYGONG

IHjet/ITAGjet , .
$PROJ_DIR$Y NN NAGD32F3x0_Firmware_Libran,CMSIS

J-Link/1-Trace

11 Stellaris $PROJ_DIRENNAAAGD32F3x0 Firmware Libran\CMSIS\GD o,

Mu-Link ]

PE micro Preinclude

STINK

Third-Party Driver

TIMSP-FET Defined symbols: (one per ling)

TIXDS
LUSE STDPERIPH DRIVER []Preprocessor output to file
GD32F350 Preserve comments

GD32F3x0_BOOT_FLASH Generate #line directives

5. #5i7Options for node ‘Project’->Linker->config->Edit->Memory Regions, R 245t F 1)
¥ FHHMEROM (Flash) RIRAMAL AHEL, 01 R-7. B2 TFF R B H# I IRETT7R -

& 2-7. BRTEREVRLTE

Vector Table Memory Regions  Stack/Heap Sizes

Ctart: End:
ROM |EEE | |ox0s01FFFF |
RAM |0x200000B0 | | 0x20003FFF |

6. fEOptions for node ‘Project’->Linker->Checksum ', 1&End address AFlash k7N, 1 &
2-8. 2 T F2/& £ 4 #fChecksum Z Efir 7k, 1 Extra Options & Tl = HH 73 il “ --keep

___checksum”,
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& 2-8. B TEEHEF K Checksum B E

Config Library Input  Optimizations Advanced Output List
#define Diagnostics Checksum Encodings Extra Options

Fill unused code memory

Fill pattern: OxFF

Start address: 0x8000000 End address: | Ox801FFFF

Generate checksum

Checksum size: |4 bytes ~ | Alignment: 4
Algorithm CRC polynomiz: ~ | |[0x4C11DET
Result in full size s

Initial value
Complement: |Asis ~ | | OxFFFFFFFF
Bit order: MSB first ~ | [JUse as input
[ Reverse byte order within word
Checksum unit size: 32-bit w

2-9. 7£ Extra Options & KRR E

Config Library Input Optimizations Advanced Output List
#define Diagnostics Checksum Encodings Extra Options

Use command line options

Command line options: (one per

--keep _checksum

10
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2.2.

Keil SR \EE TEBHE

1. MR T AL S R BUE T 05 2igd32f3x0_test.h X HRAMFIFlashil %, i &R-10. £
260d32f3x0 test.h XAEFRAMAFlash R .

& 2-10. &k gd32f3x0_test.h 32 {44 RAM F Flash 45

El#if defined (_ ARMCC VERSION) && (_ ARMCC VERSION >= 6010050)

#define FLASH START
#define FLASH SIZE
#define FLASH SIZE_WORDS
#define FLASH END

({uint32 t|*)0x08020000)

#define FLASH BLOCK SIZE ((uint32_t)512ul)

#define FLASH BLOCENUM (uint32_t) ({(uint32_t)FLASH END- (uint32_t)FLASH START) / FLASH BLOCK SIZE)
$define FLASH BLOCKNUM_ WORDS {uint32_t) ( (FLASH_SIZE_WORDS) / FLASH BLOCK_SIZE)

#define IEC TEST PARAM START

#define IEC TEST_PARAM END

#define RAM START
#define RAM END

extern vold Reset_Handler(void):
#define DefaultSystemStartUp() Reset_Handler ()
wvoid test_fail reset(void);

#endif /* (_ ARMCC VERSION) && (_ ARMCC VERSION >= €010050) */

/& 2-11. %50 ClassB FESCH2] Keil L2
=1 Project: Project
g GD32F3x0_EC

[ Application

L CMsIS

[ J GD32F3x0_Peripherals

[J GD32F3x0_EVAL

S Corocss
gel32f3x0_test_clock.c
gd32f3x0_test_flash.c
ga32f3x0_test_prerun.c

gd32f3x0_test_program_counter.c
gd32f3x0_test_param.c
gd32f3x0_test_ram.c
gd32f3x0_test_run.c
gd32f3x0_test_cpu_prerun_KEIL.s
gal32f3x0_test_cpu_run_KEIL.s
gd32f3x0_test_fullram_run_KEIL.s
[ Startup

BB E BB EEEE

A Doc
& cmsis

GRS ER A S RS, BB S BN E A E A E SRk
GD32F3x0_Firmware_Library\CMSIS\GD\GD32F3x0\Source\ARM ¥, 3 i % 3 1] 24 1ij it
R RS ISR B, IR R ARRS AT bR BTN B

| Stack_Size EQU  0x00000400 |

11
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AREA STACK, NOINIT, READWRITE, ALIGN=3
Stack_Mem SPACE  Stack_Size

__initial_sp

; <h> Heap Configuration
<0> Heap Size (in Bytes) <Ox0-OxFFFFFFFF:8>
: </h>

Heap_Size EQU 0x00000400

AREA HEAP, NOINIT, READWRITE, ALIGN=3
__heap_base
Heap_Mem SPACE Heap_Size

__heap_limit

IMPORT test_prerun

PRESERVES
THUMB

; /* reset Vector Mapped to at Address 0 */
AREA RESET, DATA, READONLY
EXPORT _ Vectors
EXPORT _ Vectors_End
EXPORT _ Vectors_Size

__Vectors DCD __initial_sp ; Top of Stack

DCD test_prerun ; Reset Handler --> test_prerun
DCD NMI_Handler ; NMI Handler

DCD USBFS_IRQHandler ; 83:USBFS

__Vectors_End

AREA CHECKSUM, DATA, READONLY, ALIGN=2
EXPORT __ Check_Sum
ALIGN

__Check_Sum DCD OxEEF15A05

12
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GigaDevice

_ Vectors_Size EQU _ Vectors_End - __ Vectors

AREA |.text|, CODE, READONLY

:/* reset Handler */
Reset Handler PROC

2. B BN ESCFIEC_TEST _BOOT _FLASH.sctr 4D, #0726 40 tAbryd: 9 75 EA& ok 1)
B4y CRE 4870 F B 8dE T B s Flashil 7, 18805 s 8 3 U AR Mo U 44 75D -

*kkkKk

; *** Scatter-Loading Description File generated by uVision ***

LR_IROM1 0x08000000 0x0001FFF8{
ER_IROM1 0x08000000 0x0001FFF8{
*.0 (RESET, +First)
*(InRoot$$Sections)

ANY (+RO)

; RW data
RW_IRAM1 0x200000B0 0x0002000

{
ANY (+RW +Z1)

; stack overflow test

STACK_IRAM2 0x200020B0 UNINIT 0x00001F40

{

gd32f3x0_test_param.o (STACK_OV_TEST, .bss.STACK_OV_TEST)

13
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startup_gd32f3x0.0 (STACK, +Last)

LR_IROM2 0x0801FFFC 0x0000004 {

ER_IROM2 0x0801FFFC 0x0000004

{
*.0 (CHECKSUM, +Last)

}

43 BN ST T £E“Options for Target -->Linker-->Scatter File” 1 5 drEditiZ 4 Bl al &k, 40 &
2-12. HBE 4 BB SR

2-12. GBI EINE S

Dw:i.l:el Tu’ge'l:] Uulyul:] Li.:hl.ngl Uzer | C/C4+4 | Asn Linkar |[|e|mg [ Ut:i.l:i.t:i.t:l
™ Use Memory Layout from Target Dialog X/0 Base: |
™ Make RW Sections Position Independert R0 Base: |mnswww

[~ Make RO Sections Position Independent
[ Dont Search Standand Libraes
W Report ‘might fail' Conditions as Errars

R/W Base |I:u2[}[:r|:n{){){){:l

disable Wamings: |

Scatter
fter [\IEC_TEST_BOOT_FLASH act J Edt.. I

Misc
cantrols
Lirker  |-cpu Cortex-M4fp "0 -
control  |=library_type=microlb -strict ~scatter " \|EC_TEST_BOOT_FLASH sct”
shing ~

0k | Canecel | Defaults | lelp |

3. f&“Options for Target'DEVICE AL &, &80 RS, W &R2-13. Device HE
FioR:

14
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& 2-13. Device AL &

Device lTa.rget ] Output ] Listing] User ] CAC++ (ACE) ] A=m l Linker ] Debuz ] Ttilities ]
|50ﬂ';\'a|e Packs J
Vendor: GigaDevice Software Pack
Device: GD32F350RB Pack: |GigaDevice GD32F3x0 _DFP.3.04
Toolset: ARM URL: http=://zd3Pmen. com/data/document=/T
Search: |
£ GD22F350RE j The GD32F3x0 device belongs to the value line of GD32 MCL s
Famiy.
€3 GD32F350R8 It iz @ new 32+bit general-purpose microcontroller based on the Am
=l GD22F250RE Cortex-M4 RISC core with best cost-peformance ratio in temms of
%2 GD3Fdex Series Eg?;ﬁ;;?;:;cessing capacity, reduced power consumption and
“% GDI2FTxx Series The Cortex-M4 core features implement a full set of DSP instructions
) to address digital signal control markets that demand an efficient,
1% GD32HTxx Series easy+o-use blend of control and signal processing capabilities.
= GD32L23x Seri
-T2 * e GD32F350 - ARM Cortex-M4 Core
\{g GD32W51x Series Frequency up to 108 MHz
Flash access zero watt state
Single-cycle multiplier and hardware divider
b ]

4. {£Options for Target->C/C++->Preprocessor Symbols sl 24 i TR 75 2 1 Pl 122 % 5
MRIS K 8, W ER-14. B G E SR

& 2-14. BEHGFEE

Device] Target] Elutputl Listing] Uzer CAC++ (ACE) ]ﬁ.sm ] Linker ] Debug ] Utilities]

Preprocessor Symbals

Define: [USE_STDPERIPH_DRIVER,GD32F3X0,GD32F350[GD32F 0_BOOT _FLASH

Undefine: |

Language # Code Generation

[~ Execute-only Code Wamings: |AC5—Iike Wamings ﬂ Language C: |c55 ﬂ
Optimization: |00 *| [ Tum Wamings into Emors Language C++: |C.H.1'| ﬂ
[ Link-Time Optimization [ Plain Charis Signed [v Short enumswchar
[~ Split Load and Store Muttiple [ Read-Only Postion Independent [ use RTTI
¥ One ELF Section per Function [ Read-Write Postion Independent [~ Mo Auto Includes
I”;!ﬁ“ﬂe |..'-...'-...'-...'-.GD32F3ﬁI}_Hnnware_Ubraw'-.CMSIS'-.GD'-.GDEEFEND'-.IncIude;..'-...'-...'-...'-.GD32F3xD_Hrrnware El
5
Misc |
Controls
Compiler |z -std=c99 —tanget=am-am-none-eabi mopu=cortex-m4 mfpu=fpv4-sp-d16 -mfloat-abi=hard ¢ A
Cfs’t"'?ml fno-tti funsigned-char fshort-enums fshort-wchar
ring W

5. MR EAE AL B 3 SECRCINY, & 2N ngen_crc.bat>3Cff, Hikin &R2-15. FEais4t
HBXAF

15
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2.3.

B 2-15. BinftsbE 4t

Devicel Target] Dutput] Listing User ]CfCH' ] Aszm ] Lin]{er] Debug ] Utilities]

Command ltems User Command v Stopon Exin. 5.

El--Before Compile C/C++ File

[ Run#1 (23| Not Specified [

[~ Run#2 23| Not Specified [
[=I-Before Build/Rebuild

[~ Run#1 [ Not Specified [

[ Run#2 (2| Not Specified [
=) After Build/Rebuild

[¥ Run#1 gen_crc.bat Ilil Mot Specified |[

[ Run#2 23| Not Specified [

[ Bun "AMfter-Build’ Conditionally
[+ Beep When Complete [ Start Debugging

6. fJo, fEUtilitiesitIiiF ik CRC_LOAD.ini, H ik &R-16. FEynini B E X AEhR.

2-16. ¥n.ini AL B SCH:
Device I Target] Dutput] Listingl User ] C/C++ I Asm I Lin](er] Debug M

Configure Flash Menu Command
{¥ Use Target Driver for Flash Programming [¥ Use Debug Driver

— Use Debug Driver — Settings V¥ Update Target before Debugging

int Fie: [\CRC_LOAD i | B
" Use BExtemal Tool for Flash Programming

Command: I _I

Arguments: I
-

Configure Image File Processing (FCARM):
Output File: Add Output File to Group:

[Application =]

Image Files Root Folder: [~ Generate Listing

eclipse A FINIEE TEBHE

WERE TREAE &AL TR R RN, (HRSTT A T A X, S8 RAM
M Flash i1 5t BB A FAE,  eclipse M85 N FIFS A SR

1. ARPE S B F & 2 gd32f3x0_test. h SCAF 1 4m3E%%_ GNU___F FIRAMIL A, fREC 11
FlashFfIRAM 4= 323 A48 20 &, 1 &R-17. #£2qd32f3x0 test.h FRAMYGLEHT 7.

16
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& 2-17. &35 gd32f3x0_test.h ' RAM iZ1 5

CI#if ('defined (_ BRMCC VERSION)) && (defined [ GNUC_))
$define ((Aiitag t *)0
#define 2 _t)FLASH START)
tdefine 2 EJFLHSJ END- (uint32_t) FLASH START)/4)
#define
$define FLASH BLOCK SIZE {(uint32_t)512ul
#define FLASH BLOCKNUM 32 T) (((uint32_t)FLASH END- (uint32 t)FLASE START) / FLASH BLOCK SIZE
#define FLASH BLOCENUM WORDS (uint32_t) ( (FLAS E_WORDS) / FLASH BLOCK SIZE)

#define IEC_TEST PAREM START ((uint3z_t *)0x2
#define IEC_TEST PARRM END {{uint3z_t *)0x2

) 0x20
*) (0x20
%) 0x
%) 0%20

#define RAM START
#define RAM DATAAREAL END
#define QAM STACK . START
#define RAM END

#define DefaultSystemStartUp()
void test_fail reset(void);

F#endif /* (!definsd (_ ARMCC VERSICN)) && (defined (_ GNUC_ )} */

2-18. % i ClassB FE3C 3] eclipse T2

v 25 gd32f350r jec test!
si-,&p‘ Binaries

! Includes
gy Application
= bin

gy CMSIS

(= Debug

lepy Doc
[Fp GD32F3x0_EVAL

iy GD32F3x0_Peripherals
~ [y IEC60730 ClassB
L gd32f3x0 _test clock.c
[5 gd32f3x0_test_cpu_prerun_eclipse.S
(55 gd32f3x0_test cpu_run_eclipse.S
L6 gd32f3x0 _test flash.c
(55 gd32f3x0_test fullram_run_eclipse.5
lg gd32f3x0_test_param.c
¢ gd32f3x0 _test prerun.c
[gy gd32f3x0_test_program_counter.c
le gd32f3x0 _test ram.c
@E gd32f3x0 test run.c

= |dscripts

= Startup
(= stubs

gen_crc.bat

HIRSSFER SRS A RS, WERRE SRS, WHEPNERAT & L0 M .s
BB, IFn AR-19. BEUESIAN 7R IAT BN, (A A fEIs AT 2 R HEAT A I .

17
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2-19. BYUE I

g .size Reset_Handler, .-Reset_Handler

pe

kS bl /'*' SystemInit */
F1/* Call SystemInit function */

F2 bl SystemInit

E3///* Call static constructors */
b4// bl _ libc_init array

F5 /*Call the main function */

Fé bl main

F7 b=z 1r

T
[

|-~

B2 .section .text.Default Handler,"ax", %progbits
2 Default Handler:

E4Infinitg_Loop:
F5 b Infinite Loop

e .size Default Handler, .-Default Handler

9 .section .isr vector,™a", ¥progbits
70 .global _ gVectors

/4 gVectors:

= .wordl_estackl /* Top of Stack */

2. & F2-20. ZENE AL B H 5T K BunE el W &R-21. £eclipse THES
BB AT R BRI 4y, AR O B TS M Flash FTRAM ) K /N E R 24 78 o

& 2-20. S EUMBCHALE

v = gd32f350r_jec test
=

i
it Includes
 Application
= bin

Ga CMSIS

= Debug

Fpy Doc
[y GD32F3x0 EVAL

(5 GD32F3x0_Peripherals
gy IEC60730_ClassB
v = |dscripts
| =/ gd32f3x0_flash.ld

= Startup

= stubs
gen_crc.bat

Binaries

18
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B 2-21. B eclipse TIE4 BnEc44

ENTRY (Reset_Handler)

/* end of Stack */
_estack =|8x208884208; |

[ B R T S ]

3]

7 /* memory map */
& MEMORY

5 {

18 FLASH (rx)
iec_test {wxa!ri)

: ORIGIN = @xesepeass,
: ORIGIN = éx2eape2ea,

12 RAM (xrw) : ORIGIN = éx2eaaaaba
13 flash_end {rxai'w) : ORIGIN =|@xBE@LlFFCE
14}

LENGTH =|128K

LENGTH = @BxB@

LENGTH =| Bx3F58 /*8K*/

LENGTH = exda

3. f&H“Debug Configurations->Debugger”+'Device namelfJlit &, HEE 4RO TS,

A-22. Device name ZZ Bk :

& 2-22. Device name Fi0 B

Name: | gd32f350r_iec_test Debug

El Main %5 Debugger I+ Startup| s Source| =] Common| &, SVD Path
J-Link GDB Server Setup

Start the J-Link GDB server locally

[JConnect to running target

Executable path: | ${jlink_path}/${jlink_gdbserver}

Browse.. |Variables..

Actual executable: |D:,-'Program Files/SEGGER/JLink/ILinkGDEServerCL.exe

(to change it use the global or workspace preferences pages or the project properties page)

Supported device names

Device name: ||GD32F350RB ||

Endianness: @) Little O Big

Connection: (® USE Qe l:l (USB serial or IP namefaddress)

Interface: ®) SWD O ITAG

Initial speed: ) Auto (O Adaptive (@ Fixed kHz

GDB port:

SWO port: [ Verify downloads Initialize registers on start
Telnet port: [FLocal host only [ Silent

Log file:

| Browse...

Other options: -singlerun -strict -timeout 0 -nogui

4 . £ T & JE M “C/IC++

Build->Settings->Tool

Settings->Cross ARM GNU

Assembler->Preprocessor” #1“C/C++ Build->Settings->Tool Settings->Cross ARM GNU C
Complier->Preprocessor” 1 s I 4 Hif A% 75 22 1) Pl %, F EAB R G 418 v AL T

W (223, (A R AR B T
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B 2-23. B G g A T F R

& Tool Settings & Toolchains i Devices & Build Steps Build Artifact Binary Parsers @ Error P/ ¢ | *

(# Target Processor [ Do not search system directories (-nostdinc)
(£ Optimization

(22 Warnings

[JPreprocess only (-E)

Defined symbals (-D) @ |D @ %
O Depaane [USE sTOPERIPHORIVER ]
USE_STDPERIPH_DRIVER
w B GNU ARM Cross Assembler GD32F350

(3 Preprocessor GD32F3x0_BOOT _FLASH
(2 Includes
(2 Warnings
(B2 Miscellaneous
w 5 GNU ARM Cross C Compiler
(22 Preprocessor
(&2 Includes
(2 Optimization
(2 Warnings
(22 Miscellaneous
w 5 GNU ARM Cross C Linker
(22 General
(22 Libraries

Undefined symbaols (-U) &)

@ Miscellaneaus
w B GNU ARM Cross Print Size
(22 General

5. 1224 “C++ Build->Settings->Build Steps->Post-build steps->Command” ' [ 4>, 11 &R2-24.
EPost-build 77 7R 8 o 24 i LREA R elf LAt

& 2-24. 1535 Post-build 54

v Resource

Linked Resources

Resource Filters Configuration: |Debug [ Active ] ~ | | Manage Configurations...
Builders
w C/C++ Build
Build Variables &3 Tool Settings B} Toolchains [l Devices 4 Build Steps Build Artifact Binary Parsers @ ErrorP|* | *
En\rlr(.:nment Pre-build steps
o
glglng Command:
Settings

Tool Chain Editor
C/C++ General
Linux Tools Path
v MCU
ARM Toolchains Path
Build Tools Path
OpenOCD Path
pyOCD Path
QEMU Path
SEGGER J-Link Path
Project References
Run/Debug Settings
Task Repository
Task Tags
Validation
WikiText

Description:

Post-build steps

Command:

I$(cross_preﬁx}${cross_objcop)‘}!ﬁ(cross_sufﬁx} -0 ihex "gd32f350r_jec_testelf”

"Project.hex";.\\gen_crc.bat; ~ ||

Description:

6. f&24*Debug Configurations->Startup” i AT H{T SCFF LT, B4 T {17 11 4155 88

& IProject.hex 4, N &R-25. B AT HAT LR BTR:

20
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MName: |gd32f350r_iec_test Debug

Main | %5 Debugger | = Startup . &~ Source| ] Common| &, SVD Path
Load Symbols and Executable
[ Load symbols
(O Use project binary: gd32f350r jec test.elf

® Use file: || ${workspace_loc\gd32f350r_iec_test\Debug\Project.hex} || Workspace... | | File System...

Symbals offset (hex): |:|

[~ Load executable
(® Use project binary: gd32f350r iec_test.elf
(O Use file:

Executable offset (hex): |:|

Runtime Options

Workspace... | File System...

[JRAM application (reload after each reset/restart)

Run/Restart Commands

Pre-run/Restart reset Type: l:l (always executed at Restart)

[ 5et program counter at (hex):

Set breakpoint at: | |test_prerun | |
[ Continue

21
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3. =FERE T IR SE R

IR R R RS AL B TR, £ 8NP T 9 i R 3 TR IFIZAT, Ik 4 R &/ 3-1.
WG R -

B 31, WRER

FrE¥EEer»»r»» IECEOT30 Test Board Init Success {C{00{000

CPU Test (PreRun) Success!

. Power reset or software reset, next step —> FWDGT reset test ...

PPNy IECAOTI0 Test Board Init Success {400

CPU Test (Prefun) Success!
FWDGT reset
. FWDGT reset test 0K next step —7 WWDGT reset test ...

FRerEyrayyy IECAOTI0 Test Board Init Success  {{€g{{00dd(e

CPU Test (Prefun) Success!

FWDGT reset
WHDGT reset

. WWDGT reset test OE, WDGT test completed ...

Full EAM Test Success!

FLASH CEC32 Test(FreFun) Success!
€

Clock Frequency Test Success!

Frogzram counter test(PreRun) Success'y

Main program starts

FLASH CEC(Run—Time) Test running' Hext Address —3 0x080001fc

FLASH CEC(Run—Time) Test running' Hext Address —3 0x080003£5

FLASH CEC(Bun—Time) Test running! Wext Address —» 0x080005f4

FLASH CBC(Bun—Time) Test runming! WHext Address —3 0x080007£0
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Important Notice

This document is the property of GigaDevice Semiconductor Inc. and its subsidiaries (the "Company"). This document, including any
product of the Company described in this document (the “Product”), is owned by the Company under the intellectual property laws and
treaties of the People’s Republic of China and other jurisdictions worldwide. The Company reserves all rights under such laws and
treaties and does not grant any license under its patents, copyrights, trademarks, or other intellectual property rights. The names and

brands of third party referred thereto (if any) are the property of their respective owner and referred to for identification purposes only.

The Company makes no warranty of any kind, express or implied, with regard to this document or any Product, including, but not
limited to, the implied warranties of merchantability and fitness for a particular purpose. The Company does not assume any liability
arising out of the application or use of any Product described in this document. Any information provided in this document is provided
only for reference purposes. It is the responsibility of the user of this document to properly design, program, and test the functionality
and safety of any application made of this information and any resulting product. Except for customized products which has been
expressly identified in the applicable agreement, the Products are designed, developed, and/or manufactured for ordinary business,
industrial, personal, and/or household applications only. The Products are not designed, intended, or authorized for use as components
in systems designed or intended for the operation of weapons, weapons systems, nuclear installations, atomic energy control
instruments, combustion control instruments, airplane or spaceship instruments, transportation instruments, traffic signal instruments,
life-support devices or systems, other medical devices or systems (including resuscitation equipment and surgical implants), pollution
control or hazardous substances management, or other uses where the failure of the device or Product could cause personal injury,
death, property or environmental damage ("Unintended Uses"). Customers shall take any and all actions to ensure using and selling
the Products in accordance with the applicable laws and regulations. The Company is not liable, in whole or in part, and customers
shall and hereby do release the Company as well as it’s suppliers and/or distributors from any claim, damage, or other liability arising
from or related to all Unintended Uses of the Products. Customers shall indemnify and hold the Company as well as it's suppliers
and/or distributors harmless from and against all claims, costs, damages, and other liabilities, including claims for personal injury or

death, arising from or related to any Unintended Uses of the Products.

Information in this document is provided solely in connection with the Products. The Company reserves the right to make changes,

corrections, modifications or improvements to this document and Products and services described herein at any time, without notice.

© 2023 GigaDevice — All rights reserved
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